
Useful programs to use with this
      This program uses a number of different compression programs. This program can do such routine 
tasks as unzipping, viewing the contents of ZIP files, and making ZIP files but PKZIP may still be 
required to do other zip chores like password protected files and is good to have anyway as any 
frequent DOS user knows.
      The useful programs to have to use the decompression features of this program are PK ZIP 204g, 
ARC 6.02, ARJ 2.41, LHA 2.13, and ZOO 2.01 and for MAC files also can use UNSTUFF.EXE 
(FREEWARE, comes in a file called UNSIT.EXE).    With this and with these programs you can 
decompress, update, recompress when done, view the contents of these compressed files, add to 
them, delete files from them, and selectively decompress files from them, all from within the 
Windows environment, even password protected ones, 

all without knowing a single one of the 
commands needed to use these files. 
      Any of these formats you wish to use should be in a path set directory, which means you should copy 
them into your \dos, \windows, or root directory which would have a line in your autoexec.bat file 
something like    path=c:\dos; c:\windows; c:\windows\system ;c:\. This means the computer can find these
files from any directory.
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How to Unzip a file
For password protected files use external pkzip.exe and pkunzip.exe. 
There are 3 ways to decompress each of the following types of compressed files which this program 
supports, ZIP, ARC, ARJ, LZH, and ZOO. You can decompress for use by clicking the name of the file, 
then the button 'Load' (or using open on the file menu, or dropping the name of the file onto the Open 
button). Decompress for use means just decompress the file so you can use the contents of it (ideal for 
when you download ZIPPED files which contain setup files which will create its own directory and 
files so you would have to erase the originals anyway), or you can 'permanently' decompress it (this 
just means it won't recompress when you exit) by clicking the ZIP tab on the bottom and then clicking 
'Uncompress' when the appropriate file is highlighted, or by just dragging the name of the file from the file 
list and dropping it onto the 'Uncompress button'. By doing this, you have 2 more options, decompress 
into the same directory the file is in or decompress into a directory equal to the name of the file. This 
means that if you are in a directory called c:\onlineservice\download and you decompress a zip file called 
newgame.zip into a new directory, ZR-FW will create a new directory c:\onlineservice\download\
newgame, copy the original file into that directory and decompress it into that directory. You can even do 
these options using password protected files.
`
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Making a compressed file
      You can use this program to ease the task of making compressed files, even making those which are 
password protected if that program supports passwords. To the best of my knowledge neither LZH nor 
ZOO does but ZIP, ARC, and ARJ most certainly do. To make a compressed file, click on 'List' on the 
menu bar and then 'Start new list' or you can click the ZIP tab on the bottom and then click 'Make ZIP', 
either way a list will be created in the middle to which you can add the names of whichever files you wish 
to include in the compressed file. Once you are done adding names to the list, click the tab at the bottom 
called 'LIST' or click 'LIST' on the main menu bar and then click 'View file list'. This will show you the 
contents of the list on a larger list. From here you can even launch the programs or files by double-
clicking them if it is an old list and you are not sure if these are the right files. From here simply click 
compress files and follow the instructions from there. The new file created will reside in the root directory 
of that drive. You can also have the    option of making single compressed files, or .exe and .txt files 
compressed.
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Setting Extensions
      This program creates a list of extensions (those 3 letters after a period telling you what kind of file it is) 
so it can load files into the appropriate programs right from within a compressed directory. You can edit it 
in Notepad by clicking 'Setup' on the menu bar and then Load extension setup nto into notepad. The first 
item in the setup file is the default for any unknown extensions. I use notepad for this as it is small and 
loads fast.
        The pattern for this setup file is the program name on the first line (odds), the extensions (you must 
have a period before the 3 letter extension) on the second line (evens), again a program name on 3rd, 
extensions on 4th and so on.
      By setting extensions ZR / ZRFW become more than just decompression tools or a file viewers, you 
can load files into any number of different programs all from the same directory again and again without 
having to go to the file menu of a program, then the open dialog box, then selecting the name, then 
clicking OK. Instead, you can just keep dropping away the names on 'Open' and load as many versions of
the program as you need. It can connect you with any program you need to use whenever you want to 
use it.
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Single compressed files
      Along with decompressing files for use and recompressing them again when exiting, this is one of ZR's
oldest features and it remains almost completely unchanged from its dos roots. Since exe (programs) are 
usually the largest pieces of a set of files and since they do not change by using them, this program can 
compress them into .exc files, then automatically uncompress them when you want to use them and 
erase them when you are done without you having to do anything at all because there is nothing that 
changes when you use it so you do not have to decide whether or not to save any changes. Ideal for 
large DOS programs you launch from Windows, for Windows programs a ZRC Directory will be created.
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Viewing picture files
 ZR PhotoView is built into ZR FileWorks only.
    This program supports JPEG, GIF, BMP,    PCX, DIB, TGA, and TIF picture files.    New formats include 
CUT, IMG, LBM, MAC, MSP, and PIC picture files. You can load files by clicking their names and then 
clicking Open or by clicking the name and then file and open from the menu bar, or dragging and dropping
the file name from the file list onto Open or by double-clicking a graphics file from file list, or by double-
clicking a graphics file name in a ZRC directory. You can zoom in or out, zoom by percentage, zoom by 
aspect ratio, or zoom by stretching the window size.    You can use scroll bars, or not use scrollbars and 
pan left, right, up or down, by clicking Z-I or Z-O, P-L, P-R, P-U, or P-D on the menu bar when window is 
smaller than picture. Mega zoom, mega panning, and super panning are still supported. You can also fine 
tune (adjust brightness, gamma, etc), mirror, rotate, resize, and cut up and save files in any of the 
supported write formats. This provides an easy way to converts Gifs or Bmps to the more compressed 
and increasingly more common Jpeg versions. There also shortcut keys for mega and super panning, 
mega zoom, flip horizontal, flip vertical, and and rotate. There are 4 ways to make a picture file fit on your 
printer. 1st is to rotate is so that the height is greater than the width (if you have standard paper sizes). 
2nd is to lower the resolution, or dots per inch. 3rd is to shrink the picture before printing. And finally, if 
you want the highest possible resolution but cannot fit the whole picture on your printer, you can cut it up 
to pieces using Copy selection and paste new. Click the mouse on the part of the picture you wish print, 
holding the mouse button down move down and to the right, release and click on Copy selection, the click
Paste new picture. You can also use this to crop out wide boarders or to to better frame your pictures. 
Shrink can also be used to make to make thumbnails of your pictures. Clicking info will tell you the size, 
type, and other info on your pictures. This can be useful when shrinking or Copy and Pasting new. Tip: 
Double clicking on the picture is a short-cut for closing.
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Open
      Open (previously called Load) is the main feature of this program and is always the default for double-
clicking a file in the main file list. Double-clicking the file list will give you access to Open even when the 
button Open has been changed to another feature by the ZIP tab or the UUE tab on the bottom bar. Open
will load compressed files into temporary ZRC directories, load picture files into the graphics viewer, run 
programs, load programs and files together if the extension of the file matches one of the extensions in 
the setup file and it will automatically decompress/ run/ recompress again (erase) .exc single compressed
files. These same events happen by using Open on the file menu and by dropping names on the Open 
button when it called 'Open' (when the Main tab is highlighted).
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ZRC directories
      A ZRC directory is what comes on when you click Load on a compressed file. This is an imaginary 
directory defined by this program for the purpose of keeping the uncompressed versions of files separate 
for temporary use. When clicking recompress (the equivalent of EXzip on previous versions) the 
uncompressed versions of files in the compressed file will disappear. For this reason, if you change any of
the files, simply click Update and the corrosponding files in the compressed file will be updated to reflect 
these changes. You can add files to existing compressed files using ZRC directories and delete unwanted
files from them. You also have access to any program listed in the setup file extensions by double-clicking
on the items in the list. This duplicates the Load feature of the main view area. You can also lauch 
programs or view graphics files, or do anything that any program you include in set extensions can do to 
any of the files listed.
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Compressed files
      Compressed files are groups of files shrunken into one smaller one for the purpose of making it less 
time consuming and costly to transfer them over telephone lines and on disks. This program extends 
that purpose to compressing just the files you don't use very often without your having to 
compress a whole drive or back them up to disks. The most common compression standard for PC 
computers is the ZIP file format. This program runs a number of these other programs which compress 
files beneath it rather than internally except for ZIP which it decompresses internally in Windows. 
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UUE files
      UUE stands for Unix to Unix Encoding. MIME stands for Multi-purpose Internet Mail Exchange. UUE is
the most common format used to send binaries (pictures, formatted text files, sound, programs, etc.) over 
the Internet, via electronic mail, or posting to Usenet or BBS's.This program now encodes and 
decodes UUE files internally and within windows. To do this click on the UUE tab on bottom, then the 
name of the file, then the UUdecode button. MIME features are supported through included (though some
sysops have been known to delete them) freeware DOS programs (MPACK and MUNPACK). This 
program supports encoding, decoding, merging broken up UUE/MIME files, breaking up UUE/MIME files 
to match you mail servers limit, and extracting UUE files from online logs. These features are available 
when clicking on the UUE or the MIME tabs at the bottom of the Window.  Additional: You can now use 
Load2 to load files into other shareware UUE or MIME decoding programs just as you can load any file 
into any program that will accept it as with loading from File Manager. Win 4 notes: The DOS window for 
UUDECODE.COM goes off automatically unless there is an error, in which case now you can actually 
read the error as it will stay on until you turn it off.    
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Main tab
      The main tab at the bottom of the screen is the default tab when the program is turned on. It sets the 
first command to Load, the second to the compressed file viewer, and the others to Make Directory, 
Remove Directory , and Rename. Make directory  makes a new directory in the currently open directory, 
remove directory removes only empty directories. To remove a full directory drop files into trash first, or if 
there is many of them, click on the 'File' menu, click 'Delete files' and click *.*, and ok.
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ZIP tab
      This tab is to give you easy access to the decompression features, Using this is not necessary for 
temporary decompression but you can use it to permanently uncompress files, start a zip file, make a 
single compressed file, or to view contents of a compressed file, though this feature is also on the Main 
tabs command buttons.
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Viewer- compressed files
      The second button on the Main tab commands and on the ZIP tab commands is the compressed file 
viewer. You can use this to view the contents and stastics of the files in a compressed file, compression 
ratios, sizes compressed, uncompressed, dates of last change, and so on, of files in a compressed file 
without having to decompressed it. You can also use this to create selective compressed directories, or 
mini ZRC directories made up of only those files which you wish to use instead of having to decompress 
all of them at once.
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Password protected files
For password protected files use external pkzip.exe and pkunzip.exe. 
    This program supports password protected files in the Zip, Arc, and Arj formats. Password protected 
means these files are scrambled using a password only the creator of the archieve knows. You must use 
this password to unscramble the files as well. To create a password protected file, chose to when asked 
when making a compressed file. To decompress a password protected file, click the green 'NP' below the 
directory list box and next to the drive box, to change it to 'PW'. These stand for 'no password' and 
'password' respectively. When loading a compressed file you will be prompted for a password if the green 
'NP' is set to 'PW'. To permanently decompress a password protected file, click the ZIP tab, then PW 
uncompress.
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List
      The list function and the ZRC Directory (formerly ZIP directory) were always the heart of ZR. One 
handled making compressed files, the other handled uncompressing and recompressing them. With List 
you can build lists of files spanning many directories and magically make them into a single compressed 
file (without moving the originals) in one step. Other list functions have also always included copying the 
list files, moving the list files, and erasing the list files. These other list functions can be done at any later 
date after you compress the files in the list and are assured that the copies of the files were not corrupted 
by the compression process. Later, one would assume you might want to move or erase the originals so 
the list is maintained until you decide to erase it.    You can also use list solely for the purpose of 
making lists of files to copy all at once to other drives and directories from any directory on the 
current drive! 
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Drag and drop events
      Using this program, in addition to drag and drop loading of files, programs, and programs and files 
together, you can drag and drop move or copy files to other directories, or delete them by dropping them 
into a trash can. To access the Copy/Move list, left click the ZR tablet in middle, to switch from copy to 
move and back click the "Copy files..." or move files label or the red letters "C" or "M". You can also drop 
the names of files into a list for compressing them, moving or copying many files at once to other drives, 
drop the names into lists of texts files or broken up UUE files to merge, drag and drop UUEncode or 
decode files, plus many other drag and drop features. One of this programs key features, building lists of 
files for compression, moving, copying, or erasing many files at once is also now a drag and drop event. 
You can also drop and add files to existing compressed files.
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Merge events
      You can use this program to merge text files or UUE files. To begin merging text files select 'Merge text
files' from File in main menu. To begin merging UUE files back into one continuous UUE file, click the 
UUE tab at bottom of the program, then click the 'Merge UUEs' button. To merge either text or uue files, 
drop names (DO NOT CHANGE directories while dropping) into center drop zone and click the green x's 
when ready to begin merging. NOTE> This is not may not work with all compressed drives. Merging text 
files is a good way to merge many multiple part UUE files at once. Simply choose merge text files, drop all
the names IN ORDER into the drop area and click green x's when done.    Then choose 'Xtract UUEs' to 
merge all the uue files at once. NOTE> Merging UUEs will not work when files are saved as one long 
continuous line instead of as normal lines under 80 characters long.
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Extract UUE files from log
      This feature is designed to extract all UUE files or multi-part UUE files which are in order from any 
online log. It searches for a Begin statement the starts tracking statements until it finds an end statement. 
If no end statement is found, the file is ended when a new Begin statement is encountered. The new files 
it extracts are called a.uue, b.uue, and so on. This feature works well with Merge text files to merge 
multiple multi-part UUE files at once.
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Readdx
      Readdx via RDX 4.0 is a 256,000 color unlimited sized DOS text reader which this program can shell 
to view text files. No other text reader has this many colors you can adjust just like the colors of a color tv, 
has search with match count, ratio driven side bars to show at a glance the size of the text, multiple user 
1 key saved color and preference settings, plus many other features.
      Readdx is also the parent program of all ZIP Runner (ZR) programs. What started out as a text reader 
which could shell to compression programs to shrink and auto-decompress text files for use was spun off 
into a version which would decompress a whole compressed file into an imaginary 'directory', which would
give a user access to read files and run programs within that directory, and then would recompress it 
when exiting that directory, is now on the verge of becoming a full fledged icon-based program manager 
to complement, if not completely replace (which it likely won't), window's own program manager, with its 
primary purpose being, of course, auto decompression for use / recompression. Such is ZR 
ProgramWorks.
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About PhotoShow Pro
      PhotoShow Pro was cut from the orginal version of ZR ProgramWorks. It use to be ZR PhotoView Pro 
but that was just a demo of what ZR ProgramWorks was supposed to be, a program manager with built-in
graphics. PhotoShow is like the built-in ZR PhotoView but has the ability to make thumbnails and do 
slideshows, plus a multiple document interface, system file editor, and built-in icon editor plus other stuff 
like ZR7 style loading and UUE/MIME merging.
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New to version 7 features
            ALL Windows unzipping and zip file viewing, uuencoding, decoding. Sound and Movie file playing, 
more picture file formats and runs with later Win95 betas.
            Many new picture formats have been added as well as support for AVI movie files, MIDI and WAV 
sound files, CD-ROMs, and support for Mac features such as shelling to UNSTUFF.EXE (if you have it) 
for .SIT files when clicking the ZIP tab and the Unzip button, and uses Quicktime for Windows (tm Apple 
Inc) as a default for Mpeg and MOV movie formats because that program (PLAYER.EXE) comes free with
magazines on CD-ROM, I believe. You can still load them into other Mpeg viewers using Load2.
          There are 3 new list features, all convienently located where you'd expect to find them and are as 
easy to access as right clicking. Behind door number 1 (directory list) you have a new Hyperdrive  (HD) 
list which can take you to any directory you set faster than even the previous directory warp feature.    
Behind the file list is a new version of a old favorite, ZR Favorites, a list of your most common used files 
feature found in earlier verisons of ZIP Runner. The third is behind the ZR tablet in the middle (right click, 
not left).    This is Load2 (pronounced 'load to' <g>) which you can use to load any file into any program 
which supports that file type and loading files from other programs.    Each of the these lists is easy to 
maintain, simply highlight a file name in the file box and click the plus for each one to add (below the 
directory list box for Hyperdrive, beside the file list box when a file is selected for favorites, and near the 
Load2 list when Load2 is visible). Click the name and then the minus when lists are visible to remove an 
item (With Hyperdrive and favorites the plus turns into a minus when list is visible).
          Also new is the size of the files given in Kilobytes beside the name of the file in the file list, a bar 
graph (ala ZR ProgramWorks, PhotoShow Pro, PhotoView Pro) showing the free memory/resources 
since ZR FileWorks does function as a program manager for compressed files as well as provides a 
common format for uncompressing different types of compressed files. You can also now save lists of files
using the LIST function (its on the List menu on top bar, save list a .ZRL file), this way if there are groups 
of files you copy often, you can easily save the list, and load it again anytime as you would load any other 
file, simply by double-clicking the list or clicking on the file name and then load. 
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About ZR ProgramWorks
 

      ZR ProgramWorks is the real program manager of the ZR programs with built-in unzipping and treats zip 
files just like program groups. It has been made smaller by removing its extraneous features and moving some
to other programs also included in ZR Program Center. Since it was designed to work with ZR FileWorks, the 
picture viewing has been moved to ZRFW. Icon editing has been dropped as it is a program manager which 
primarily does not use icons, though you still can use icons with it if you really have to. ZR IconWorks still 
comes with PhotoShow Pro so you still get everything if you buy the entire ZR Program Center (ZR FileWorks, 
PhotoShow Pro, ZR ProgramWorks and Readdx 4 (RDX)) at $42 which is the only way ProgramWorks is 
offered. ZR ProgramWorks may be released on its own as a shareware program anyway. Its features include 
group in group, capability easy access to your system files, clock, alarm, system resource graph, etc.
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Graphing directories
 
      You can use this feature to graph sub-directories or a whole drive, though it works best for sub-
directories. This gives you the size of the directory including all its sub-directories and percentages on 
directories many layers deep. To begin, click 'Graph directory' from the File menu or click on 'Graph (x 
many) directories' in the bottom right hand corner of the window. Graphing a whole drive can take a 
minute or two if you have hundreds of mb like I do but for the short wait it gives you a wealth of 
information. In addtion to the size of the total of all subdirectories and their subdirectories 1 level deep,    
and their realtive sizes as percentages of the total drive, once it is done and you can click on the name of 
any of those 1 level deep sub-directories to find out the sizes of ALL sub-directories ALL levels beneath it 
and their precentages realtive to that second subdirectory. In other words, if you found out one directory 
was taking up 30% of your drive, a single click would tell you which directories beneath it had what 
percentages of it which would be causing it to be so big. Plus it graphs the current directories subs total 
sizes on a pie chart to visually show you which directories are hogging the most space.
        You can also graph files in a directory to see their relative sizes as well.
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Register
      Shareware is does not mean free, though it is still one of the best deals under the sun. You get to try 
out really neat stuff and you are trusted to pay for what you like. This means EVERYBODY, not just the 
idle rich or people who test programs for a living, get to see whats at the cutting edge, new or unique, 
without having to spend a fortune to see if the programs really live up to the promises on the box.
      Too many people don't register to warrant shareware releases of most products and many good 
programs die out because people think it really doesn't make a difference. DON'T KID YOURSELF, if you
don't bother, who's to say anyone else will? If you want to see better programs along the lines of ones you
like, only paying for them can make it happen.

If you would like to register this program and receive the programs described within the program under 
Register info on the Help menu, send a check or money order to...

                      Scandere Software
                      PO Box 1329
                      Dennisport, MA    02639
or register via Compuserve, GO SWREG, Register ID number 4470 for ZR FileWorks or 
number 3165 for ZIP Runner. If you would like to contact me regarding other payment options, 
mulitple users licenses, or setup info, the e-mail address for support of this program is Jared10@aol.com
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Help for ZIP Runner/ZR FileWorks
    Contents
        Everything All the Time
            What's new to Version 7
                How do I...    (Click me first)
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                      How to unzip a file
                      Making a compressed file
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                      Dragging and Dropping
                      Loading files
                      ZR File List
                      Viewing contents of compressed files
                      Viewing graphics files
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How do I...
View a picture Play a movie Play a sound file 
Decompress a file View compressed file contents
Make a compressed file Decompress a password protected file
Add to compressed files Delete from compressed files 
Update files in compressed files Repack a compressed file 

 Move files / Copy files Load any file into any program 
Directory warp Hyperdrive Access your favorite files 
Copy files from a CD  Play a music CD  

                                  UU/MIME encode or decode files Merge UU or MIME files
Extract UUE files from logs Breakup UU/MIME files to mail 
Graph file sizes Graph sub-directory sizes 
Make lists of files Save list files to use later 

 Delete files Make directory Remove Directory 
Renaming files Set file extensions to load files automatically
Changing ZR.ini file View thumbnail gallery files 
Slide show open pictures  
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Everything all the time
 
          The most common rule for success with shareware used to be to make one little program which did 
one thing better than any others. I am pretty far off that mark :>. This program does so much I have to 
spend nearly as much time trying to remember everything that it does as I did making it do it in the first 
place. What is the advantage of this for you? You get one common program which does lots of things you 
previously had to use many programs to do, and even then you had to keep switching back and forth 
between them. ZIP Runner / ZR FileWorks were the first programs to allow you running one program 
(and controling sub-programs when necessary) to take some received multi-part UUE files of a 
compressed file, merge the pieces back into one single UUE file, uudecode it,    unzip it, use the contents 
of it (run programs from it, load text from it, view picture files with it), refresh it and repack it (zip it back 
up again (EXzip 5/94). The reverse is also true. You can use it to make compressed files of programs, 
pictures, sound, etc., UU encode them so they can be mailed over the Internet, and break them up to 
match your server's mail size limit.
          Now to do each one of these things better than everyone else is a tall order, and most should know 
that one single program probably will never be the best at any given moment in doing each and all of 
these things. Yet each of the things that this program does which other programs also do, it usually does 
in a new and novel way. The ZRC (ZIP) directories for instance and the Repack (ExZip on exit). This plus
the List feature and the Favorites list made ZIP Runner distinct among the Win unzipping shells. 
Eventually everyone else catches up though. The drag and drop UUE merging was different too. I may 
not be the best at everything but each feature which other programs also do, I do try to do better.
            Now to the gist. With the new Load2 feature, you can use just the features you think this 
program does best and use other programs for ones you feel are below par. Some people use this 
program as a ZIP shell / program manager. Others use it as a UUE merger and picture viewer. I use it 
most as a file loader to load files into notepad or other programs, especially text files in zip files. Whatever
you want it to do that it does, it does notably. If someone else does one of its features better, that's ok too,
load the file into that one. Even if you use other programs with it but still use it, please register it. 
          This program now stops after merging uue files in case you care to use another uudecoder. If you 
prefer a different program to play CD's, ok (but CD-Sat is unbelievably good at saving you memory). The 
audio/video features are simple and quick, it just plays them, no fancy superfluous windows, meters or 
what-not, and no waiting for fancy meters and what-not to load either (but you still get total and current 
time display readouts, pause and stop controls). If you want to edit an A/V file, you can use Load2 to load 
it to another program. Everything still works around the ZRC directory principle, check out whats in the 
zip files, read the contents, run the programs, hear the sound clips, view the pictures, watch movies if any,
then use Repack if you realize its not what you wanted anyway.
          Both ZIP Runner and ZR FileWorks are blueprints for any other unified super-utility yet to come. No 
doubt others will come by-the-by by people with deeper wallets and less originality. I only hope I'm still 
around to give them a ZIP run for their money too.

Jared DuBois
Scandere Software.    
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Glossary

A
Access your favorite files 
Add to compressed files 

B
Breakup UU/MIME files to mail 

C
Changing ZR.ini file 
Copy files from a CD 

D
Delete files 
Delete from compressed files 
Directory warp 

E
Extract UUE files from logs 

G
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Graph sub-directory sizes 

H
Hyperdrive 

L
Load any file into any program 

M
Make directory 

P
Play a movie 
Play a music CD 
Play a sound file 

R
Remove Directory 



Renaming files 
Repack a compressed file 

S
Save list files to use later 
Slide show open pictures 

U
Update files in compressed files 

V
View thumbnail gallery files 



Play a movie
Double click filename or click file name and then Open. For AVIs repeat to restart movie. 
Video for Windows 1.1 is needed for AVIs. For MPG or MOV, Quicktime (TM Apple Inc) for 
Windows (Player.exe) or other viewer is required. Click Playing... on bottom bar to pause, 
double-click to stop.



Play a sound file
To play a WAV or MIDI file, double click on filename or click filename then Open. On bottom 
bar, click where it says Playing... to pause, double-click to end.



Update files in compressed files
After opening a file into a ZRC directory, if you change any of the files when using, click the 
Update button before clicking the Repack button. This will save the changes.



Add to compressed files
After opening a compressed file into a ZRC directory you can Add to it by clicking the Add (or
the yellow X in the upper right hand corner) and then dragging and dropping the name from 
the file list to the center list. Clicking the X in that box will resize ZRC directory back to 
normal.



Delete from compressed files
To delete files from a compressed file, load the file into a ZRC directory and click the Delete 
file button.



Repack a compressed file
After opening a file into a ZRC directory, you can repack the contents (erase again) when 
done by clicking on the Repack button. This is the only way to exit. To permanently unzip 
files use ZIP tab on bottom. To save changes use Update button first.



Save list files to use later
Click on List on menu bar, then 'save list as .ZRL file'. Enter up to eight letters for the 
filename. Do not add the extension. It is done automatically.



Play a music CD
Put a audio CD disk in your CD-ROM drive and click CD on menu bar, then Play CD using CD-
Satellite. This program is REALLY small, smart, and works even after ZRFW is turned off.



Access your favorite files
Right click the list of files on the left-hand side of the window. To add to the list click the 
name of the file you wish to add and then the yellow '+' sign beside it. When viewing your 
favorites, you can remove it by clicking the '-' (what was +).



Copy files from a CD
You can easily copy files from CD-roms to your hard disk. Click the name of the file to copy 
and press the F9 key. This copies it to your grab bag directory you can setup by clicking CD 
on the menu and then set grab bag directory.



Hyperdrive
To go to any directory on any drive from any directory on any drive, right click the directory 
box on the right hand side of the window. To save directories, once in a directory click the 
plus sign below. To remove, click the name to remove and then the minus sign (previously 
the plus).



Directory warp
To warp to any directory or subdirectory on any drive, push the F8 key and type where you 
want to go.



Load any file into any program
Using the new Load2 feature you can load files in any other program which accepts them. To
access the Load2 list, right click the ZR tablet in the middle. Click the file name where the 
files are listed, then double-click the name of the program you wish to load it into. Use '+' to 
the right of Load2 to add programs, the '-' immediately to the left to remove programs from 
the list.



View thumbnail gallery files
In ZR FileWorks you can now view and load pictures from thumbnail galleries made with 
PhotoShow Pro. Click A/V items, then PhotoView, then click the picture icon to look for .gal 
(gallery) files.



Slide show open pictures
To make a slideshow using open picture files, click File then Slideshow to begin. To end click 
on End Slideshow on menu bar. FileWorks only.



Extract UUE files from logs
If you have an online log which has UUE files in it you can click the UUE tab then the 
filename then the extract button. It not only can extract uues to names like a.uue b.uue etc. 
but can merge them at the same time if they are multiparts and in order.



Breakup UU/MIME files to mail
If your mail server has a limit on the size of files, if you wish to mail a uue encoded file, you 
may have to break it up first. To do this click on the uue tab, the filename and the Breakup 
button. Set the size of your services limit. (AOL was recently 26000, Cserve 63000)



Graph file sizes
To graph the size of the files in the current directory, click File on the menu bar then Graph 
files or push the F7 key.



Delete files
To erase files click on the filename and holding the left button down 'drag' in into the 
trashcan. There are no prompts asking if you are sure so be sure. Easy access to your 
undelete program is for when you were not sure but should have been.



Make directory
On the main tab, click the Make Dir button to make new directories in the current open 
directory.



Remove Directory
To remove EMPTY directories, click the Remove Dir button on the main tab. To delete files 
first use 'delete files' on the File menu or if there is just a few, drag and drop them into the 
trashcan.



Renaming files
You can rename files using the Main tab and by clicking the name of the file, then the 
rename button.



Graph sub-directory sizes
To graph or find the total size of the current directory plus all sub-directories of it, click File 
on the menu bar then Graph Directory.



Changing ZR.ini file
If you move the program and it files to another directory, you must change the ZR.ini file in 
your windows directory. It is just a file with 1 line saying where the programs are like c:\
zrunner 
To change this click Setup, then Change ZR.ini file.






